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INTRODUCTION

This document contains additions and corrections to the documentation set that accompanies 

the Xerox® EX 560 Print Server, Powered by Fiery®.

The documentation set for users and system administrators consists of these documents: Color 

Printing, Configuration and Setup, Fiery Color Reference, Fiery Graphic Arts Package, Printing, 

Utilities, Variable Data Printing, Workflow Examples, and Welcome. The documentation set 

describes version 1.1 of the Xerox® EX 560 Print Server, Powered by Fiery®. This Customer 

User Addendum describes the additional features included in version 2.0.

For a complete description of your Xerox® EX 560 Print Server, Powered by Fiery®, use this 

document in conjunction with the other documents in the documentation set.

NOTE: In the documentation set, the term “Fiery” refers to both the EX Print Server and the 

Fiery Controller. Information that is specific to the Fiery Controller is not applicable to 

version 2.0. Only information about the EX Print Server is applicable.

What is new in version 2.0?

This version of the Xerox® EX 560 Print Server, Powered by Fiery® is the same as version 1.1, 

plus the following features:

• Operating system upgraded from Windows XP Pro to Windows 7.

• Fiery system software upgraded from System 9, Release 2 to System 10, which adds 

support for the following features:

Feature For information, see

Sequential Print Command WorkStation Help

PrintMe cloud printing For information about setting up PrintMe 
cloud printing, see “PrintMe cloud printing” 
on page 20. For information about printing 
through PrintMe cloud printing, see 
“PrintMe cloud printing” on page 50.

Preinstalled Pantone Plus spot color libraries For information about managing spot color 
libraries, see Color Printing > Spot-On.

Optimize RGB Transparency print option “Optimize RGB Transparency” on page 70

Updated calibration features, including status 
notification in Command WorkStation and 
calibration based on selected job

“Calibration” on page 74



INTRODUCTION 8

• Fiery user software upgraded from Release 3e to Release 4.0.1, which adds support for the 

following features:

Fiery Ticker, a status display that runs on the
Fiery Advanced Controller Interface (FACI)

Fiery Ticker Help

Enhanced FreeForm print option “Enhanced FreeForm” on page 78

Feature For information, see

Feature For information, see

Updates to Windows and Mac OS support “System requirements” on page 12

Fiery JDF includes the following improvements: 
automatically generated Fiery print controller-
based printer finishing options, improved job 
reporting and media reporting to JDF systems, 
improved printer state tracking for JDF systems, 
and run-list editing by operators, including editing 
of content files already submitted

Command WorkStation Help

Job Properties includes Set Page Device media 
mapping

“Print options” on page 54

Fiery Remote Scan includes easier connection to 
the EX Print Server and a simpler workflow for 
saving and initiating scans

“Fiery Scan” on page 64

Command WorkStation includes in-line editing in 
the Job List of the job name and number of copies, 
applying server presets from the Job List, job error 
reporting, and updates to Command WorkStation 
preferences including default finish size

“Command WorkStation” on page 59

Fiery Driver includes additional support for 
Windows 8, Windows Server 2012, Mac OS v10.7, 
and Mac OS v10.8

“Addendum to Printing” on page 23

Hot Folders includes filters for PDF/VT and JDF 
jobs

Hot Folders Help

Fiery JobMaster, Impose, and Compose support 
electronic licensing. (Fiery Impose and Fiery 
Compose were formerly part of Fiery SeeQuence 
Suite.)

“Fiery JobMaster, Impose, and Compose” on 
page 61

Direct Mobile Printing allows direct printing to the 
EX Print Server from mobile devices

“Direct Mobile Printing” on page 49

Web Services for Devices (WSD) printing protocol 
allows printing from Windows 7 and Windows 8 
computers, and Windows 8-based tablets

“Web Services for Devices printing” on 
page 53
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Terminology and conventions

This document uses the following terminology and conventions.

Term or convention Refers to

Aero EX Print Server (in illustrations and examples)

Copier Xerox® Color 550/560 printer

EX Print Server Xerox® EX 560 Print Server, Powered by Fiery®

Titles in italics Documents in this set: Color Printing, Configuration and Setup, 
Fiery Color Reference, Fiery Graphic Arts Package, Printing, Utilities, 
Variable Data Printing, Workflow Examples, Welcome

Windows Windows 8, Windows 7, Windows XP, Windows Vista, 
Windows Server 2003/2008/2008 R2/2012

Topics for which additional information is available by starting 
Help in the software

Tips and information

A warning concerning operations that may lead to death or injury 
to persons if not performed correctly. To use the equipment safely, 
always pay attention to these warnings.

A caution concerning operations that may lead to injury to persons 
if not performed correctly. To use the equipment safely, always pay 
attention to these cautions.

Operational requirements and restrictions. Be sure to read these 
items carefully to operate the equipment correctly, and avoid 
damage to the equipment or property.
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ADDENDUM TO WELCOME

This chapter describes additions and corrections to Welcome.

User documentation

Disregard Welcome > Installing user documentation. The EX Print Server does not ship with a 

User Documentation CD. User documentation for this product is only available online.

Set up the EX Print Server

Disregard Welcome > Basic Steps to Print > Set up the Fiery with Configure. In Welcome, the 

graphic of the copier touch panel is not accurate. The title of the topic is also misleading, 

since it explains how to perform Setup from the copier touch panel rather than Configure (the 

title says “with Configure”). Refer to procedure provided in this chaper, To Set Up the EX Print 

Server.

TO SET UP THE EX PRINT SERVER

1 On the copier touch panel, press Services Home.

2 Press the Fiery icon.

3 Make sure that the EX Print Server is Idle.

If Printing or RIPping appears, the EX Print Server is processing, and you must wait until the 

system finishes and reaches Idle.

4 Press the Setup tab.

5 Log on with Administrator privileges.

The default Administrator password is Fiery.1 (case-sensitive).

6 Perform Setup.

This is the minimum required for initial Setup. Later, you can complete the remaining Setup 

menus, from a network computer.

The EX Print Server must reboot in order for the changes in Setup to take effect.
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Install printer drivers on user computers

Disregard Welcome > Basic Steps to Print > Install PostScript printer drivers on user computers 

for TCP/IP printing. In Welcome, the folder structure of the User Software DVD is not 

accurate. Other portions of the installation process are not accurately described or are unclear. 

Refer to this topic instead.

TO INSTALL PRINTER DRIVERS ON USER COMPUTERS

From a Windows XP client computer:

1 Insert the User Software DVD into the disc drive.

When the Fiery User Software installer starts, close it.

2 On the User Software DVD, navigate to Printer Drivers\Ps_drvr and double-click the Setup.exe 

file.

3 In the Fiery Driver Installer, follow the on-screen instructions.

• Select a language.

• Accept the license agreement.

4 In the Add Printer Wizard, follow the on-screen instructions.

• Select Local printer attached to this computer.

• Select Create a new port, and then select Standard TCP/IP Port from the drop-down list.

5 In the Add Standard TCP/IP Printer Port Wizard, follow the on-screen instructions.

• Enter the EX Print Server address or DNS name.

If prompted for additional port information, select Generic Network Card as Standard for 

Device Type.

6 In the Add Printer Wizard, follow the on-screen instructions.

• Select a printer from the list.

• Type the printer name and, if desired set the printer to be used by default.

• Select “Do not share this printer.”

• Select Yes to print a Test Page.

• Click Finish.

The files are installed.
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System requirements

Make sure that you meet the system requirements in Welcome > System requirements for user 

computers, with the following additions and exceptions:

Printer drivers and Fiery applications are supported on

• Windows 8 (32- and 64-bit)

Windows 8, Pro, Enterprise, RT

• Windows Server 2012 (64-bit)

Datacenter, Standard, Essentials, Foundation

• Mac OS v10.8 (Intel-based Mac OS computer)

• Mac OS v10.7 (Intel-based Mac OS computer)

Printer drivers and Fiery applications are no longer supported on

• Windows 2000

• Mac OS v10.4

• Mac OS v10.3.9

Direct Mobile Printing

Direct Mobile Printing is supported on mobile devices with Apple iOS 4.2 or later and print 

functionality:

• iPad (1st generation or later)

• iPhone (4, 4S, 5)

• iPod touch (3rd generation or later)
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ADDENDUM TO CONFIGURATION AND SETUP

This chapter describes additions and corrections to Configuration and Setup.

Connecting the EX Print Server to the network

In Configuration and Setup > Preparing for Fiery Controller Setup > Connecting network 

cable to the Fiery Controller, refer only to the EX Print Server network connection.

Install and configure printer drivers

Before you can print from a client computer to the EX Print Server, you must first install a 

printer driver on each client computer and then configure each computer to include EX Print 

Server and copier-installed options.

After you install and configure printer drivers, you can print from any application on a client 

computer to the EX Print Server.

For more information about installing printer drivers, including installing printer drivers on 

other operating systems, see Printing.

Setup option reference

The following print options are available for the EX Print Server.

Set Page Device option

• To access the following option, choose Configure > PDL > SPD.

Option Settings
(default is underlined)

Description

Enable Set Page Device 
Mapping

On, Off Allows the EX Print Server to recognize and apply 
attributes to jobs (for example, media, stapling, duplex, 
output bin tray, and other attributes). Once set, this option 
is available in Job Properties.
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Web Service for Devices

• To access the following option, choose Configure > Network > Service > WSD.

Updating system and user software

Using the tools System Updates and Check for Product Updates (Software Downloads Site), 

you can obtain updates to EX Print Server System Software and User Software from a secure 

site on the Internet (referred to throughout this documentation as the Update Server). 

Before updating the EX Print Server

Keep in the mind the following before updating the EX Print Server using System Updates or 

Check for Product Updates:

• If you reinstall system software onto the EX Print Server hard drive disk from DVDs, all 

patches and updates previously downloaded and installed are deleted and must be 

reinstalled. You should obtain the most recent patches from the Update Server 

immediately after system software is reinstalled.

• If the EX Print Server is behind a firewall and unable to access the Internet, the site 

administrator can configure a proxy server at the customer’s organization to allow the EX 

Print Server to receive updates.

• While updates are being installed, you cannot print to the EX Print Server. Schedule 

automatic updates when no one plans to print. While updates are being installed, the EX 

Print Server may need to reboot several times. 

• To view updates that have already been installed, print the Configuration page or access 

Check Now and click the History tab. Check Now is available when you access System 

Updates directly from the Fiery Advanced Controller Interface.

Option Settings
(default is underlined)

Description

Enable WSD On, Off Allows printing from Windows 7 and Windows 8 
computers and tablets.

WSD Queue Print Queue, Hold Queue, Direct Connection, 
Sequential Queue

Specify the type of print connection.
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• The list that displays when you access Check for Product Updates (Software Downloads 

Site) may include: 

– Updates that are unavailable through System Updates and/or are not approved for all 

users.

– Updates that may already be installed on some EX Print Server print servers. To help 

you choose the updates to download, compare the list displayed with the EX Print 

Server print server’s Configuration Page > Updates log.

NOTE: Check Now is not available when you access System Updates from Command 

WorkStation or WebTools.

System Updates

System Updates allows you to schedule regular inquiries to an Update Server on the Internet 

for available EX Print Server updates. The EX Print Server checks automatically for updates 

by contacting the Update Server periodically.

System Updates also allows users to obtain updated versions of EX Print Server user software 

(utilities) and install them on client computers that connect to the EX Print Server. The 

updated applications are first downloaded from the Update Server to a partition on the EX 

Print Server hard drive disk. Users access the EX Print Server over the Internet and download 

the updated applications onto client computers and then manually install them.

You can also view and download updates at any time using the Check Now feature from the 

Fiery Advanced Controller Interface. Use Check Now to view and manually download 

updates that are available for installation (Patches tab) and/or view a list of updates that have 

already been installed (History tab).

You can also start Check Now by clicking an update notification in the task bar on the EX 

Print Server monitor.

Access System Updates in the following ways:

• Directly from the Fiery Advanced Controller Interface (if supported)

• From a client computer through WebTools > Configure tab > Launch Configure > 

Enter the administrator password > Server> System Update

• From a client computer through Command WorkStation > Server menu > Configure > 

Server > System Update
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TO SCHEDULE SYSTEM UPDATES 

1 Access System Update.

You can access System Updates directly from the Fiery Advanced Controller Interface or from 

a client computer using WebTools or Command WorkStation. 

If you access System Updates directly from the Fiery Advanced Controller Interface, an 

additional feature, Check Now, is available. Check Now lists the updates that are currently 

available (Patches tab) and the updates that have already been installed (History tab). 

NOTE: Check Now is not available when you access System Updates from Command 

WorkStation or WebTools. 

NOTE: While updates are being installed, you cannot print to the EX Print Server. Schedule 

automatic updates when no one plans to print. The EX Print Server may also need to reboot 

several times during the update process. 

2 Select “Check for important system updates” (or “Enable System Updates” in Command 

WorkStation or WebTools).

3 Specify how often the EX Print Server contacts the Update Server.

This feature sets a schedule for installing, downloading, and notification of updates.

4 Choose a method for updating the EX Print Server operating software, system software, and 

utility software:

• Automatically download and install updates (preferred method): Automatically 

downloads updates to the EX Print Server and installs them. Your intervention is not 

required.

• Download updates and send notification: Automatically downloads updates to the EX 

Print Server, but does not install them; sends a notification that updates have been 

downloaded. After the updates are downloaded, you install the updates manually.

From the Fiery Advanced 
Controller Interface 

From a client using Command WorkStation From a client using WebTools

• Click Start > All programs > 
Fiery > System Updates.

• Start Command Workstation.

• Log on as Administrator with the 
appropriate password.

• Choose Configure from the Server menu.

• Choose Configure > Server > System Updates.

• Start a web browser, type the IP address or 
DNS name of the EX Print Server, and then 
press Enter.

• Click the Configure tab, and then click 
Launch Configure.

• Log on with Administrator privileges.

• Choose Configure > Server > System 
Update.
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• Send notification when updates are available: A notification displays in the EX Print 

Server task bar when new updates are available for download from the Update Server. To 

manually download the updates to the EX Print Server, access Check Now by clicking the 

notification in the task bar.

5 If you use a proxy server to connect through a firewall to the Update Server, click Proxy 

Settings.

NOTE: The setting names differ slightly depending if you access System Updates from either 

the Fiery Advanced Controller Interface or from Configure. The differences are noted.

6 Select Use Proxy (Fiery Advanced Controller Interface) or Enable Proxy (Configure), and type 

the appropriate information in the following fields:

• Proxy Address (Fiery Advanced Controller Interface) or Address (Configure): proxy server 

IP address

• Proxy Port (Fiery Advanced Controller Interface) or Port (Configure): port used by the 

proxy server

• Proxy User (Fiery Advanced Controller Interface) or User Name (Configure): user name 

for accessing the proxy server

• Proxy Password (Fiery Advanced Controller Interface) or Password (Configure): password 

for accessing the proxy server

7 In the Proxy Settings window, click OK (Fiery Advanced Controller Interface) or Save 

(Configure).

8 Click OK (Fiery Advanced Controller Interface) or Apply (Configure).

Using Check Now 

Check Now is available when you access System Updates directly from the Fiery Advanced 

Controller Interface (if supported).

Use Check Now to view updates that are available for installation (Patches tab) and updates 

that have already been installed (History tab). 

NOTE: Check Now is not available when you access System Updates from Command 

WorkStation or WebTools. 

TO VIEW AND INSTALL UPDATES USING CHECK NOW

1 At the EX Print Server, click Start > All Programs > Fiery > System Updates.

The System Update Preferences dialog box appears.

2 Click Check Now at the bottom of the screen, and then do any of the following:

• To view a description of an update, select it in the list.

• To install the update, click Install.

• To view updates that have already been installed, click the History tab.
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• To close the window without installing an update, click the X in the upper-right corner.

Check for Product Updates (Software Downloads Site)

Check for Product Updates (also known as the Software Downloads Site) allows you to access 

the Update Server to view and manually download all available updates for EX Print Server 

System and User Software. You can access Check for Product Updates from the Configure tab 

in WebTools.

Check for Product Updates is especially useful if your EX Print Server cannot access the 

Internet, is behind a firewall, or is otherwise unable or not configured to seek and accept 

automatic updates from the Update Server. (For instance, if you do not want—or the EX 

Print Server is unable—to take advantage of the auto-download/auto-installation/

auto-notification features available through System Updates.) 

TO INSTALL UPDATES USING CHECK FOR PRODUCT UPDATES

1 Launch a Web browser, type the IP address or DNS name of the EX Print Server, and then press 

Enter.

2 Click the Configure tab, and then click Check for Product Updates.

A window appears listing available updates.

NOTE: The list that displays when you access Check for Product Updates may include: 

• Updates that are unavailable through System Updates and/or are not approved for all 

users.

• Updates that may already be installed on some EX Print Server print servers. To help you 

choose which updates to download, compare the list displayed with the EX Print Server 

print server’s Configuration Page > Updates log.

3 For each update that you want to download, click the file name under Download and then 

select Save to download the update file to a location on the client computer.

When the update files have been downloaded, browse to the location of the update file on 

the client computer and handle it according to the file type, circumstances, and site.
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Mobile device printing
Direct Mobile Printing allows direct wireless printing to the EX Print Server from supported 

mobile devices. Supported mobile devices must be connected to the same wireless-network 

subnet as the EX Print Server to print using Direct Mobile Printing.

EX Print Server Setup for Direct Mobile Printing

Before using Direct Mobile Printing, configure the following settings in Configure:

• Network > Protocol > TCP/IP > Security:

Specify ports to turn or select Enable Port Filtering

Available Ports > 5353 (Multicast DNS): selected

Available Ports > 80 (HTTP): Selected

Available Ports > 631 (IPP): Selected

• Network > Services > Web:

Enable Web Services: Selected

Enable IPP: Selected

• Network > Services > Bonjour:

Enable Bonjour: Selected

Enable Direct Mobile Printing: Selected

• Printer > General:

Publish Print Queue: Selected

Make sure that the EX Print Server settings are configured as specified. Direct Mobile 

Printing will not work if these settings are changed.

For more information about these settings, see Command WorkStation Help.

Additional Direct Mobile Printing requirements

In addition, observe the following configuration requirements:

• You can print documents with a secure password using Fiery User Authentication (see 

Configuration and Setup > Preparing for EX Print Server Setup > Levels of access and 

control > Users and Groups > User authentication).

• If Direct Mobile Printing is running on more than one EX Print Server, be sure to assign a 

distinct Bonjour name to each EX Print Server.

User authentication problems result if more than one EX Print Server is assigned the same 

name.
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• Make sure that the EX Print Server is connected to a wireless access point on the network.

• Make sure that supported mobile devices are connected to the same wireless network as 

the EX Print Server.

For more information about how to print using Direct Mobile Printing, see page 49.

PrintMe cloud printing

Users with a PrintMe subscription can upload a document to the PrintMe cloud service and 

then print the document to the copier using the copier touch panel.

• The PrintMe feature on the EX Print Server requires a subscription to the PrintMe cloud 

service.

• Xerox, Inc. guarantees communication between only EFI PrintMe cloud service and the 

EX Print Server.

• For information or support related to the PrintMe cloud service, contact Electronics for 

Imaging at printmesupport@efi.com.

• PrintMe availability may vary, depending on the country or region.

Setting up PrintMe cloud printing

You must set up the EX Print Server through Configure to enable PrintMe cloud printing.

TO SET UP PRINTME CLOUD PRINTING

1 Log in to Configure.

For information, see Configuration and Setup > Setting up the EX Print Server from a 

Network Computer > Accessing Configure from a network computer.

2 Enable PrintMe cloud printing.

• Click PrintMe.

• Select Enable PrintMe.

NOTE: (optional) If you need PrintMe cloud printing to connect to the EX Print Server 

through a proxy server, configure settings for the proxy server.

– Select Proxy Settings.

– Enable Proxy and enter proxy server information.

– Save your settings.

• Click Apply.

For more information about using PrintMe cloud printing, see page 50.
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VDP Search Path

The EX Print Server can search multiple locations both on network computers and on the EX 

Print Server for VDP (Variable Data Printing) resources (for example, Postscript images and 

fonts). With Configure, you can specify a location to search by setting a “file search path” 

(sometimes also called a “common global search path”). Inform users of the paths that you 

specify so that their jobs can access the resources.

The EX Print Server searches for a VDP resource in the following order:

• Path that the user specified in the job

• Paths specified in Configure

• Path that the application specifies for VPS or PPML resources when it generates the data 

stream

For any of these paths, the EX Print Server searches the folder, and then the subfolders within 

that folder. 

TO SPECIFY LOCATIONS TO SEARCH FOR VDP RESOURCES

1 In Configure, in PDL  >  VDP, click the Add button.

For information, see Configuration and Setup > Setting up the EX Print Server from a 

Network Computer > Accessing Configure from a network computer.

2 In the Add Path dialog box, enter a path.

If you type the path name, use the format of a mapped drive (for example, Z:\folder) or a 

UNC (for example, \\computer name\folder).

3 If the path is located on a computer that requires authentication, select Remote Server 

Authentication, enter a user name and password, and click OK.

4 Repeat steps 2 and 3 as needed to add additional paths.

5 Click Apply.

Job error reports

If errors occur when the EX Print Server is processing or printing jobs, you can submit a job 

error report to Technical Support.

The job error report captures important information for Technical Support to troubleshoot 

and resolve issues such as job errors, system failures, or unexpected print output. Job error 

reports collect job files, logs, and information about the EX Print Server.

When you create a job error report, Command WorkStation collects job files, logs, and 

information about the EX Print Server, and saves them to a zip file. Before sending the zip file 

to Technical Support, you can remove any files contained in the zip file for security purposes.



ADDENDUM TO CONFIGURATION AND SETUP 22

NOTE: Print jobs do not need to be in an error state for generating job error reports. You can 

create a job error report for any jobs in the Held or Printed queues.

TO CREATE A JOB ERROR REPORT

1 In Command WorkStation, select a job in the Printed or Held list. 

2 On Windows, press Ctrl and right-click the job. On Mac OS, press Command and right-click the 

job.

3 In the shortcut menu, click Create Error Report.

4 Enter information about the job error.

• Enter comments and any additional details in the text field, such as steps for Technical 

Support to reproduce the error.

• (Optional) Include “Rasters” and “Color Profiles” in the report.

• (Optional) Attach files to the report, such as a PS file.

5 Save the job error report to a specified folder.
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ADDENDUM TO PRINTING

This chapter describes additions and corrections to Printing.

Windows 8, Windows Server 2012, Mac OS X v10.7 and v10.8 printer drivers are supported 

for the EX Print Server.

The following are not supported for the EX Print Server:

• Windows 2000 printer driver

• Mac OS X v10.4 and v10.3.9 printer drivers

• Job Monitor

This chapter covers the following for the new supported printer drivers, methods to print to 

the EX Print Server, and print options:

Installing Windows printer drivers with Point and Print

SMB printing (also known as Windows or WINS printing) allows you to install PostScript 

printer drivers on your computer from the EX Print Server with Point and Print, and print to 

a particular connection (Print queue, Hold queue, Direct connection, Sequential Print queue, 

or Virtual Printer).

Sequential Print allows the EX Print Server to maintain the job order on certain jobs sent 

from the network. The workflow is 'First In, First Out' (FIFO), respecting the order in which 

the jobs were received over the network. For more information, see Command WorkStation 

Help.

Each connection (print, hold, direct, sequential print or the name of the virtual printer) 

requires a separate installation. Repeat the procedure for each connection.

Section See

Installing Windows printer drivers with Point and Print page 23

Setting up Windows computers for printing page 32

Installing Mac OS printer driver files page 39

Setting up Mac OS computers for printing page 41

Printing methods page 49

Print options page 54
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When you install the printer driver using Point and Print, you cannot configure installable 

options manually. The installed options are displayed as the EX Print Server configuration in 

the printer driver. For more information, see “Configuring installable options” on page 38.

BEFORE YOU BEGIN

Ask your administrator to do the following in Setup on the EX Print Server:

• Assign the EX Print Server a valid IP address.

The IP address or DNS name is required in the following procedure.

• Configure the EX Print Server for SMB printing.

NOTE: SMB printing is referred to as Windows Printing in Setup and on the Configuration 

page. 

For more information, see Configuration and Setup or Configure Help.

TO SET UP SMB PRINTING ON WINDOWS COMPUTERS

1 Windows 8/Server 2012: Press the Windows button on the keyboard to open the Start screen. 

Open the Search charm by moving the mouse pointer to the upper-right or lower-right corner 

of the screen, move it up or down, and click Search. Type Control Panel in the search box, tap 

or click Apps, and then tap or click Control Panel in the results. Click Network and Sharing 

Center. Type network in the Search field to view all options. Click the View network 

computers and devices link from the Network and Sharing Center list.

2 Windows 8/Server 2012: Type the name of the EX Print Server in the Search field and click 

Enter.

If you cannot locate the EX Print Server, contact your EX Print Server administrator.

3 Double-click the name of the EX Print Server to display active print connections.

NOTE: For a description of each print connection, see Configuration and Setup.

4 Double-click the connection that you want to set up (print, hold, direct, sequential print or 

virtual printer).

The files are installed on your computer.
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NOTE: You may receive a message that you are about to connect to a printer on the EX Print 

Server, which will automatically install a printer driver on your machine. Click Yes to 

continue.

5 Windows 8/Server 2012: Press the Windows button on the keyboard to open the Start screen. 

Open the Search charm by moving the mouse pointer to the upper-right or lower-right corner 

of the screen, move it up or down, and click Search. Type Control Panel in the search box, tap 

or click Apps, and then tap or click Control Panel in the results. Click Devices and Printers.

Windows XP: Click Start and choose Printers and Faxes.

The printer is displayed in the Printers or Printers and Faxes window.

6 Windows 8/Server 2012: Right-click the EX Print Server icon and choose Printer properties.

7 Click Print Test Page on the General tab.

If the Test Page prints successfully, you are ready to print from the computer.

8 Repeat the previous steps for the other connections that you want to set up.

Downloading printer drivers from the EX Print Server

You can download printer drivers files to your computer directly from the EX Print Server 

over the network, and then install them following the procedures in “Installing printer drivers 

from the User Software DVD or downloaded from WebTools” on page 26.

TO DOWNLOAD PRINTER DRIVER FILES FROM THE EX PRINT SERVER

1 Windows 8/Server 2012: Press the Windows button on the keyboard to open the Start screen. 

Open the Search charm by moving the mouse pointer to the upper-right or lower-right corner 

of the screen, move it up or down, and click Search. Type Control Panel in the search box, tap 

or click Apps, and then tap or click Control Panel in the results. Click Network and Sharing 

Center. Type network in the Search field to view all options. Click the View network 

computers and devices link from the Network and Sharing Center list.

Windows XP/Server 2003: Right-click Network Neighborhood or My Network Places, and 

select Find Computer or Search for Computers.

2 Windows 8/Server 2012: Type the name of the EX Print Server in the Search field and click 

Enter.

If you cannot locate your EX Print Server, contact your administrator.

3 Double-click the name of the EX Print Server.

A folder called PC_User_SW is displayed along with the active print connections.

4 Double-click the PC_User_SW folder and browse to the Print Drivers\Ps_drvr folder.

Follow the instructions for your operating system to install the printer driver. The procedures 

are the same as for installing from the User Software DVD or downloaded from WebTools.
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Installing printer drivers from the User Software DVD or downloaded 
from WebTools

The following procedures describe installing the printer driver from the User Software DVD.

To install the printer driver on a Windows 8, Windows 7, or Windows Server 2003/2008/

2008 R2/2012 computer, select the same printer driver file as for Windows XP/Vista, 

described in the following procedure.

NOTE: The following procedures use Windows XP illustrations. 

This procedure describes the installation of a local printer (Port 9100). You can modify the 

printing protocol later, according to your network type.

TO INSTALL AND COMPLETE THE PRINT CONNECTION FOR WINDOWS

1 Insert the User Software DVD into the DVD drive, type the name of the DVD drive (for 

example, D:\), browse to the Print Drivers\Driver_Installer folder, and double-click setup.exe.

NOTE: When you insert the User Software DVD into the DVD drive, the Fiery Driver 

Installer may start automatically.

Or

From WebTools, after the printer driver files are copied to the specified location, the Fiery 

Driver Installer starts automatically.

2 In the Fiery Driver Installer dialog box, select the printer driver language and click Next.

The Fiery Driver Installer installation wizard appears.

3 Click Next in the Welcome to the InstallShield Wizard for Fiery Driver Installer dialog box.

4 Read the license agreement, click “I accept the terms of the license agreement” and click 

Next. 

5 Windows XP/2003: Click Next in the Welcome to the Add Printer Wizard dialog box.

Windows 8/Server 2012: Click “The printer that I want isn’t listed.”

6 Windows XP/Server 2003: Specify printing using a Local printer, clear the “Automatically 

detect and install my Plug and Play printer” option, and then click Next.

Windows 7/Vista/Server 2008/Server 2008 R2: Select Add a local printer.

Windows 8/Server 2012: Select Add a local printer or network printer with manual settings.

7 Select Create a New Port, select Standard TCP/IP Port from the Type of port menu, and then 

click Next.

8 Windows XP/Server 2003: Click Next in the Welcome to the Add Standard TCP/IP Printer Port 

Wizard dialog box.

The Add Standard TCP/IP Printer Port Wizard dialog box appears. Proceed to step 9.

Windows 7/Vista/Server 2008/Server 2008 R2: Type the host name or IP address of the EX 

Print Server, and then click Next. Proceed to step 11.
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Windows 8/Server 2012: Type the host name or IP address of the EX Print Server. Select the 

Query the printer and automatically select the driver to use check box. Click Next and proceed 

to step 11.

9 Windows XP/Server 2003: Type the printer name or IP address of the EX Print Server and click 

Next. 

10 Windows XP/Server 2003: Click Finish to close the Add Standard TCP/IP Printer Port Wizard 

dialog box.

NOTE: If the device is not found on the network, the device is displayed, instead of the Finish 

button. If a device is not found on the network, that could be for one of the following reasons:

• EX Print Server is not turned on.

• Network is not connected.

• EX Print Server is not configured properly.

• IP address is not correct.

If you encounter one of these situations, you can continue to set up the port by configuring 

the port manually. See “To set up Standard TCP/IP Port (Raw or LPR) for Windows” on 

page 33 and follow steps 11 through 14 before proceeding to step 11.

11 In the Printers box, select your printer and click Next.

12 Type a name for the EX Print Server in the Printer name field, and click Next.

This name is used in the Printers window and the queues window.

13 Follow the on-screen instructions.

Indicate whether you want to make it the default printer. Do not share the printer and do not 

print a Test Page at this time. 

Continue with the printer driver installation and at the last screen, click Finish.

The necessary files are installed on your hard disk drive. 
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14 Configure the installable options.

For more information, see “Configuring installable options” on page 38.

15 To set up a connection other than Port 9100, proceed to “Setting up printing connections” on 

page 32.

16 To use the printer driver, you must select the following options on the Advanced tab of the 

printer driver:

• Spool print documents

• Start printing immediately

• Print spooled documents first

Installing the printer driver on a 64-bit Windows computer from a 
32-bit Windows Server 2003 computer

If your network users print to the EX Print Server with Windows Server 2003 (32-bit) print 

sharing, and 64-bit Windows XP users are also on your network, you must add the 64-bit 

printer driver to the Windows Server 2003 (32-bit) computer, so that users can install the 

printer driver on their computers using Point and Print. We do not recommend installing the 

printer driver from a server (32-bit) to client computer (64-bit). When you install the 64-bit 

printer driver to the computer (32-bit), the Windows Server 2003 (64-bit) CD is required.

TO ADD THE 64-BIT PRINTER DRIVER TO A 32-BIT WINDOWS SERVER 2003 COMPUTER

1 Install the EX Print Server printer driver on the Windows Server 2003 computer.

For instructions, see “Installing printer drivers from the User Software DVD or downloaded 

from WebTools” on page 26. During the installation, when asked if you want to share the 

printer, select Yes.

2 In the Printer & Faxes window, right-click the printer that you just installed and select 

Properties.

3 Click the Sharing tab and click Additional Drivers.

4 Select the x64 components and click OK.

5 Browse to the printer driver files and select the oemsetup.inf file.

6 When prompted, insert the Windows Server 2003 x64 Installation CD into the drive of the 

computer running Windows Server 2003.

7 On the CD, browse to the AMD64 folder and click OK.

The printer driver installation is complete.
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Installing and connecting to a virtual printer

A virtual printer allows you to print to the EX Print Server using a predefined set of job 

settings. You do not have to set print options manually. Before you can print to a virtual 

printer, the administrator must create and configure the virtual printer using Command 

WorkStation. After the virtual printer is set up, you can install the printer driver and printer 

description files on your computer from the EX Print Server using Point and Print.

For more information about setting up virtual printers, see Command WorkStation Help.

When you install the printer driver with Point and Print, you cannot configure installable 

options manually. Installable options are configured automatically. The installed options are 

displayed in the printer driver when you select the Two-Way Communication option.

TO SET UP A VIRTUAL PRINTER ON WINDOWS COMPUTERS WITH POINT AND PRINT

1 Windows 8/Server 2012: Press the Windows button on the keyboard to open the Start screen. 

Open the Search charm by moving the mouse pointer to the upper-right or lower-right corner 

of the screen, move it up or down, and click Search. Type Control Panel in the search box, tap 

or click Apps, and then tap or click Control Panel in the results. Click Network and Sharing 

Center. Type network in the Search field to view all options. Click the View network 

computers and devices link from the Network and Sharing Center list.

2 Windows 8/Server 2012: Type the name of the EX Print Server in the Search field and click 

Enter.

If you cannot locate the EX Print Server, contact your network administrator.

3 Double-click the EX Print Server name to display active print connections.

Virtual printers are listed along with the Print queue, Hold queue, Direct connection, and 

Sequential Print queue (if those connections are active). Virtual printers are usually assigned 

names that indicate the type of job for which they are set up.

4 Right-click the virtual printer that you want and select Connect.

The files are installed on your computer.

5 Windows 8/Server 2012: Press the Windows button on the keyboard to open the Start screen. 

Open the Search charm by moving the mouse pointer to the upper-right or lower-right corner 

of the screen, move it up or down, and click Search. Type Control Panel in the search box, tap 

or click Apps, and then tap or click Control Panel in the results. Click Devices and Printers.

The virtual printer is displayed in the Printers (or Printers and Faxes or Devices and Printers) 

window.

You can print to a virtual printer as you would print to the EX Print Server. Depending on 

how the virtual printer is configured, you may not be able to set some print options.

NOTE: If you use Command WorkStation to import a PostScript file to a virtual printer and 

the file already specifies the number of copies, the setting for the number of copies in the 

PostScript file takes precedence over the number of copies set in the virtual printer.
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NOTE: When you print to a virtual printer installed with Point and Print, you must open the 

Printing Preferences window and click OK before the job is printed. This applies the virtual 

printer settings to the job.

Turning on Two-Way Communication

You must turn on the Two-Way Communication option to automatically update your printer 

driver to reflect the options currently installed on the copier.

NOTE: You must log on with Administrator privileges to add or change the installable options 

after the Windows 8 printer driver is installed. For more information, see “Configuring 

installable options” on page 38.

TO TURN ON TWO-WAY COMMUNICATION

1 Windows 8/Server 2012: Press the Windows button on the keyboard to open the Start screen. 

Open the Search charm by moving the mouse pointer to the upper-right or lower-right corner 

of the screen, move it up or down, and click Search. Type Control Panel in the search box, tap 

or click Apps, and then tap or click Control Panel in the results. Click Devices and Printers.

Windows XP: Click Start and click Printers and Faxes.

2 Windows 8/Server 2012: Right-click the EX Print Server icon and select Printer properties.

3 Click the Accessories tab.

4 Select the Two-Way Communication check box.

5 Type the EX Print Server IP address or DNS name. 

6 Select Update Fiery Driver When Opened to display the printer’s current default settings when 

the printer driver is opened. 

7 Click Update.

NOTE: To confirm that Two-Way Communication is turned on, click the About tab and check 

that the EX Print Server name and other server information are displayed. 

8 Click OK.
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Uninstalling printer drivers

The Printer Delete Utility is installed and used locally. You do not need to connect to the EX 

Print Server before you use the software.

TO INSTALL AND USE THE FIERY PRINTER DELETE UTILITY

1 Install the Fiery Printer Delete Utility using one of the following methods:

• Download the Client Software Installer for Windows from WebTools.

Start your Internet or intranet browser and type the DNS name or IP address of the EX 

Print Server. Click the Downloads tab. Click the link to install and follow the on-screen 

instructions.

• Insert the User Software DVD into the DVD drive of the computer.

The Fiery Installer starts automatically.

2 In the window that appears, select Modify, and then click Next.

3 Select the Fiery Printer Delete Utility check box, and follow the on-screen installation 

instructions.

4 Click Start, select Programs or All Programs, and then select Fiery. 

5 Select PrinterDeleteUtility.

The Printer Delete Utility dialog box appears. Any EX Print Server printer drivers found on 

your computer are listed.

6 To delete a printer, select the check box next to the printer name and click Delete the 

Selected Printers.

To delete all of the installed printer drivers, select the Delete All Printer Drivers check box, 

and click OK.

7 When you finish deleting printer drivers, click Exit and restart your computer.
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Setting up Windows computers for printing

Now that the printer driver files are installed, you need to configure the proper connection for 

your networked EX Print Server printer.

To print from Windows computers, you or the administrator must perform the 

following tasks to set up a connection other than Port 9100:

• Set up network servers, if any.

• Set up the EX Print Server to accept print jobs from your computer.

• Configure a port on each Windows computer for the network type.

Setting up printing connections

The EX Print Server supports the following printing connections:

• SMB

• Standard TCP/IP (RAW or LPR)

• IPP or IPP over SSL

• FTP 

For the location of each procedure, see the following table.

Completing the SMB printing connection

If your network does not have a Windows server, Windows computers can still print to the 

EX Print Server. This method of printing is SMB printing (also known as Windows or WINS 

printing). When users send print jobs, Windows computers operate in a peer-to-peer 

environment and communicate directly with the EX Print Server. 

SMB printing allows the EX Print Server to be listed on the network, so that Windows client 

computers can print to a particular print connection (Print queue, Hold queue, Direct 

connection, Sequential Print queue, or Virtual Printer) on the EX Print Server without using 

other networking software. Windows printing runs via TCP/IP. You must configure TCP/IP 

on the EX Print Server and on all computers that use SMB printing.

Procedure See

Completing the SMB printing connection page 32

Completing Standard TCP/IP Port (Raw or LPR) printing connections page 33

Completing IPP connections page 37

Configuring installable options page 38
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After you turn on SMB printing on the EX Print Server, you can set up the Windows or SMB 

connection and install the printer driver in one procedure. For more information, see 

“Installing Windows printer drivers with Point and Print” on page 23.

Completing Standard TCP/IP Port (Raw or LPR) printing connections

After you install the PostScript and printer driver files, you can add or configure the Setup 

for the Standard TCP/IP Port (Raw or LPR) connection as follows:

• Prepare the EX Print Server to accept print jobs using Standard TCP/IP Port (Raw or 

LPR) protocols. 

• Turn on LPD or Port 9100 on the EX Print Server. 

• Configure the computer for the TCP/IP connection.

For more information about Setup, see Configure Help.

Before you complete the following procedure, contact your system administrator for the 

IP address assigned to the EX Print Server.

The TCP/IP protocol should be installed as a default on the Windows computer. For Port 

9100, you can set up the connection and install the printer driver in one procedure.

NOTE: You can also set up the LPR Port connection by installing Print Services for UNIX, 

which is supplied as an add-on Windows component. For more information, see the 

documentation that accompanies Windows.

TO SET UP STANDARD TCP/IP PORT (RAW OR LPR) FOR WINDOWS

NOTE: The following procedure uses Windows XP illustrations.

1 Windows 8/Server 2012: Press the Windows button on the keyboard to open the Start screen. 

Open the Search charm by moving the mouse pointer to the upper-right or lower-right corner 

of the screen, move it up or down, and click Search. Type Control Panel in the search box, tap 

or click Apps, and then tap or click Control Panel in the results. Click Devices and Printers.

2 Windows 8/Server 2012: Right-click the EX Print Server icon and select Printer properties.



ADDENDUM TO PRINTING 34

3 Click the Ports tab.

4 To add a new port, click Add Port.

To change the port settings, proceed to step 11. 

5 Windows 8/Server 2012: Select Standard TCP/IP Port from the list of Available port types and 

click New Port. 

The Add Standard TCP/IP Printer Port Wizard dialog box appears.

6 Click Next. 
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7 Type the EX Print Server IP address. 

8 Click Next.

9 Make sure that Generic Network Card is selected as Standard for Device Type and click Next.

10 Click Finish to close the Add Standard TCP/IP Printer Port Wizard dialog box, and then click 

Close in the Printer Ports dialog box.

To change the default setting, proceed to step 11. 

If you do not want to change the default setting, the setting is now completed.

NOTE: Port 9100 was set as the default setting in “Installing printer drivers from the User 

Software DVD or downloaded from WebTools” on page 26.

11 Click Configure Port on the Ports tab of the Properties dialog box.

The Configure Standard TCP/IP Port Monitor dialog box appears.
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12 To use LPR printing, select LPR in the Protocol area and LPR Byte Counting Enabled in the LPR 

Settings area.

NOTE: You can also proceed without selecting LPR Byte Counting Enabled.

To use Port 9100 printing, select Raw in the Protocol area. 

The port number 9100 automatically appears in the Raw Settings area. This is the default 

port number. You can print to the printer connection selected for Port 9100 printing on the 

EX Print Server.

To specify a specific port number, see the following step.

13 Type the name of the print connection.

For LPR, enter print or hold for Queue Name or published virtual printer name. The Direct 

connection is not supported for LPR printing.

For Port 9100, type the following port numbers for each print connection in the Raw Settings 

area:

EX Print Server default: 9100

direct: 9101

print: 9102

hold: 9103

NOTE: Type the number exactly as shown.

14 Click OK to close the Configure Standard TCP/IP Port Monitor dialog box.

NOTE: The EX Print Server supports printing in the IPv6 environment on Windows 8, 

Windows 7, Windows Vista, and Windows Server 2008/Server 2008 R2. 

NOTE: LPR printing in the IPv6 environment is supported on the Windows XP/Server 2003 

computer from a command line, but other methods may work.

15 Click Apply in the EX Print Server Properties dialog box, and then click OK.
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Completing IPP connections

With Internet Printing Protocol (IPP), print jobs are sent to the EX Print Server over 

the Internet.

Before you begin, perform the following tasks:

• Make sure that the EX Print Server is configured for TCP/IP printing and IPP printing. 

For more information, see Configure Help.

• Specify the printing destination on your computer.

NOTE: IPP over SSL connections is supported.

TO SET UP IPP PRINTING WITH WINDOWS

1 Windows 8/Server 2012: Press the Windows button on the keyboard to open the Start screen. 

Open the Search charm by moving the mouse pointer to the upper-right or lower-right corner 

of the screen, move it up or down, and click Search. Type Control Panel in the search box, tap 

or click Apps, and then tap or click Control Panel in the results. Click Devices and Printers.

2 Windows 8/Server 2012: Click Add a printer.

3 Windows 8/Server 2012: Select Add a network, wireless, or Bluetooth printer.

4 Windows 8/Server 2012: If the printer search takes a long time, click Stop, and then click 

“The printer that I want isn’t listed.”

Windows 8/Server 2012: Click Select a Shared printer by name, and in the URL field, type the 

IP address or DNS name of the EX Print Server, followed by the name of the connection (print, 

hold, or direct).

NOTE: For example, http://10.10.10.150/ipp/print or http://DNS name of EX Print Server/

ipp/print sends the job to the Print queue on the EX Print Server.

NOTE: The URL for the printer is not case-sensitive. 

5 Windows 8/Server 2012: Click Next.
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6 Windows 8/7/Server 2008/Server 2008 R2/Server 2012: Click Install driver.

7 If you are installing the PostScript printer for the first time, follow the procedure “To install 

and complete the print connection for Windows” on page 26, step 11.

8 Indicate whether you want to make the EX Print Server the default printer and click Next.

9 Click Finish.

Configuring installable options

After you complete the printer driver installation, you must configure the EX Print Server for 

the options installed on the copier to allow the EX Print Server to take advantage of the copier 

options. Configure the options manually, or for TCP/IP network connections, use the 

Two-Way Communication option to configure the options automatically.

For information about specifying installable options, see printer driver Help.

NOTE: Windows 8, Windows 7, Windows Vista, and Windows Server 2008 R2 have a User 

Account Control (UAC) feature. You must log on with Administrator privileges to add or 

change the installable options after the printer driver is installed.

TO CHANGE INSTALLABLE OPTIONS

1 Windows 8/Server 2012: Open the Devices and Printers Control Panel.

2 Windows 8/Server 2012: Right-click the EX Print Server printer icon, select Run as 

administrator, and then select Printer properties.

The User Account Control dialog box opens. 

3 Select the User that has administrator privileges, type the password, and then click OK. 

4 Windows 8/Server 2012: Right-click the EX Print Server printer icon again and select Printer 

properties.

5 Click the Accessories tab and make your selections.

6 Click Apply, and then click OK.

Configuring installable options for printer drivers installed with the Add Printer 
Wizard

If you install the printer driver from Add Printer Wizard and then use Two-Way 

Communication to configure the installable options, the installable options are not 

configured properly. After you install the printer driver, you must properly configure these 

options.

TO CORRECTLY CONFIGURE INSTALLABLE OPTIONS

1 After you install the printer driver, right-click the printer icon, select Properties, click the 

Accessories tab, and then select your installable options.

2 Click OK or Apply.
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Installing Mac OS printer driver files

Installing printer driver files is the first step in setting up the EX Print Server as a printer. 

NOTE: If the EX Print Server printer driver is already installed, you must uninstall it before 

you install a new driver. This section provides additional information on the following: EX 

Print Server Printing > Mac OS > Uninstalling printer driver files.

The following sections describe how to install the printer files for the EX Print Server.

Installing printer drivers from the User Software DVD

The User Software DVD provides the software for Mac OS computers, such as the printer 

drivers. 

TO INSTALL MAC OS PRINTER DRIVER FILES

1 Quit all open applications.

2 Insert the User Software DVD into the DVD drive.

3 Double-click Fiery Printer Driver Installer.dmg and then the Fiery Printer Driver Installer icon.

4 Click Continue in the Welcome to the Fiery Driver Installer window.

5 Read the license and click Continue.

6 Click Agree to continue with the installation.

7 Click Install and follow the on-screen instructions.

The Fiery Printer Driver Installer installs the printer driver files that correspond to the EX 

Print Server.

Procedure See

Installing printer drivers from the User Software DVD page 39

Downloading printer drivers with WebTools page 40
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Downloading printer drivers with WebTools

WebTools allow you to download printer driver installers to your computer directly from the 

EX Print Server, if your administrator has configured access to WebTools. For more 

information about setting up and starting WebTools, see Utilities.

NOTE: A link to WebTools in the About tab of Job Properties is not available from the Mac 

OS X v10.7 and v10.8 printer drivers.

TO DOWNLOAD PRINTER DRIVERS WITH WEBTOOLS

1 Start your Internet or intranet browser and type the DNS name or IP address of the EX Print 

Server.

2 Click the Downloads tab. 

3 Click the Printer Files link for Mac OS X.

A file named OSX.dmg is downloaded to your desktop. 

NOTE: If the file is not on the desktop, open the Downloads folder.

4 Double-click OSX.dmg and then the Fiery Printer Driver Installer icon.

5 Read the license and click Agree.

6 Follow the on-screen instructions.
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Setting up Mac OS computers for printing

The following sections describe how to set up the EX Print Server on a Mac OS computer.

Setting up printing with Mac OS X v10.8

Use the following procedure to set up the EX Print Server on a computer running Mac OS X 

v10.8.

TO SET UP THE EX PRINT SERVER FROM THE PRINT DIALOG BOX

1 Open a file in your application.

2 Select Print from the File menu.

The Print dialog box appears.

3 Select Add Printer from the Printer menu.

In the dialog box that appears, select a printer connection. Use one of the printer connections 

in the following table to add a printer.

TO SET UP THE EX PRINT SERVER WITH PRINT & SCAN

1 Select System Preferences from the Apple menu, and then select Print & Scan.

The Print & Scan dialog box appears.

2 Click the “+” button to add a printer.

In the dialog box that appears, select a printer connection. Use one of the following 

connections to add a printer.

Procedure See

Setting up printing with Mac OS X v10.8 page 41

Setting up printing with Mac OS X v10.7 page 45

Printing connection See

Default (Bonjour) page 42

IP Printer page 44
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TO ADD A PRINTER WITH THE DEFAULT (BONJOUR) CONNECTION

NOTE: Bonjour printer setup works only if the EX Print Server and the Mac OS client 

computer are on the same TCP/IP subnet on the network. Bonjour must also be configured 

on the EX Print Server.

1 Click the Default icon in the dialog box.

The names of printers with default connections are listed. The virtual printers that are 

configured at the EX Print Server are also listed.

NOTE: The names of the virtual printers appear as printer name:virtual printer name in the 

Printer Name list.

NOTE: Any published virtual printer is available over LPR and FTP.

NOTE: SMB printing is not supported for Mac OS X v10.8.

2 Select the EX Print Server from the list.

The information about the selected printer appears at the bottom of the Default pane. 

The appropriate printer driver file for the EX Print Server is automatically selected. If your 

administrator configured the Secure Access printing at the EX Print Server, the printer driver 

file for Secure Access printing is selected.

3 Click Add.

The EX Print Server name appears in the list of printers.

4 Select EX Print Server.

5 Click Options & Supplies, and then click the Driver tab.
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6 Specify the installable option settings, and then click OK.

For information about configuring installable options, see printer driver Help.

NOTE: The following applies to the Bonjour connection using the EX Print Server printer 

driver on Mac OS X v10.8.

TO OBTAIN THE IP ADDRESS OF THE EX PRINT SERVER

1 Select System Preferences from the Apple menu, and then select Print & Scan. 

2 Select the EX Print Server from the list and then click Options & Supplies.

3 Click the General tab, and then click Show Printer Webpage.

The WebTools page for the EX Print Server appears.

4 Click the Configure tab.

5 Scroll to Network Protocol Setup, locate the IP address for the EX Print Server, and record it 

for future reference.

The IP address is needed to turn on Two-Way Communication in the printer driver.

For information about Two-Way Communication, see printer driver Help.

6 Click File > Close Window to close WebTools.

7 Click OK to close the Options & Supplies pane.

8 Close the Print & Scan dialog box.



ADDENDUM TO PRINTING 44

TO ADD A PRINTER WITH THE IP PRINTER CONNECTION

1 Click the IP icon in the dialog box.

2 LPD printing: Select Line Printer Daemon - LPD from the Protocol list, type the EX Print Server 

IP address or DNS name in the Address field, and then type the print connection (print or 

hold) in the Queue field. Proceed to step 4.

Port 9100 printing: Select HP Jetdirect - Socket from the Protocol list, type the EX Print 

Server IP address or DNS name in the Address field. The Queue field can be left empty. 

Proceed to step 4.

IP printing: Select Internet Printing Protocol - IPP from the Protocol list and type the EX Print 

Server IP address or DNS name in the Address field. Proceed to step 3.

The IP address or DNS name appears in the Name field.

3 Type “ipp/” followed by the print connection (print, hold, direct, or name of virtual printer) 

in lowercase letters in the Queue field.

NOTE: The EX Print Server requires a queue name. Do not leave the Queue field empty.

4 Choose Select Printer Software from the Use menu. 

5 Locate the copier manufacturer or model in the list, select the printer driver file, and then 

click OK. 

6 Click Add.

The installable options pane in the Print & Scan dialog box appears. 

7 Specify the installable option settings, and then click OK.

The EX Print Server with its IP address appears in the list of printers.

For information about configuring installable options, see printer driver Help.
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Setting up printing with Mac OS X v10.7

Use the following procedure to set up the EX Print Server on a computer running Mac OS X 

v10.7.

TO SET UP THE EX PRINT SERVER FROM THE PRINT DIALOG BOX

1 Open a file in your application.

2 Select Print from the File menu.

The Print dialog box appears.

3 Select Add Printer from the Printer menu.

In the dialog box that appears, select a printer connection. Use one of the printer connections 

in the following table to add a printer.

TO SET UP THE EX PRINT SERVER WITH PRINT & SCAN

1 Select System Preferences from the Apple menu, and then select Print & Scan.

The Print & Scan dialog box appears.

2 Click the “+” button to add a printer.

In the dialog box that appears, select a printer connection. Use one of the following 

connections to add a printer.

Printing connection See

Default (Bonjour) page 42

IP Printer page 44
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TO ADD A PRINTER WITH THE DEFAULT (BONJOUR) CONNECTION

NOTE: Bonjour printer setup works only if the EX Print Server and the Mac OS client 

computer are on the same TCP/IP subnet on the network. Bonjour must also be configured 

on the EX Print Server.

1 Click the Default icon in the dialog box.

The names of printers with default connections are listed. The virtual printers that are 

configured at the EX Print Server are also listed.

NOTE: The names of the virtual printers appear as printer name:virtual printer name in the 

Printer Name list.

NOTE: Any published virtual printer is available over LPR and FTP.

NOTE: SMB printing is not supported for Mac OS X v10.7.

2 Select the EX Print Server from the list.

The information about the selected printer appears at the bottom of the Default pane. 

The appropriate printer driver file for the EX Print Server is automatically selected. If your 

administrator configured the Secure Access printing at the EX Print Server, the printer driver 

file for Secure Access printing is selected.

3 Click Add.

The EX Print Server name appears in the list of printers.

4 Select EX Print Server.

5 Click Options & Supplies, and then click the Driver tab.

6 Specify the installable option settings, and then click OK.

For information about configuring installable options, see printer driver Help.
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NOTE: The following applies to the Bonjour connection using the EX Print Server printer 

driver on Mac OS X v10.7.

TO OBTAIN THE IP ADDRESS OF THE EX PRINT SERVER

1 Select System Preferences from the Apple menu, and then select Print & Scan. 

2 Select the EX Print Server from the list and then click Options & Supplies.

3 Click the General tab, and then click Show Printer Webpage.

The WebTools page for the EX Print Server appears.

4 Click the Configure tab.

5 Scroll to Network Protocol Setup, locate the IP address for the EX Print Server, and record it 

for future reference.

The IP address is needed to turn on Two-Way Communication in the printer driver.

For information about Two-Way Communication, see printer driver Help.

6 Click File > Close Window to close WebTools.

7 Click OK to close the Options & Supplies pane.

8 Close the Print & Scan dialog box.
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TO ADD A PRINTER WITH THE IP PRINTER CONNECTION

1 Click the IP icon in the dialog box.

2 LPD printing: Select Line Printer Daemon - LPD from the Protocol list, type the EX Print Server 

IP address or DNS name in the Address field, and then type the print connection (print or 

hold) in the Queue field. Proceed to step 4.

Port 9100 printing: Select HP Jetdirect - Socket from the Protocol list, type the EX Print 

Server IP address or DNS name in the Address field. The Queue field can be left empty. 

Proceed to step 4.

IP printing: Select Internet Printing Protocol - IPP from the Protocol list and type the EX Print 

Server IP address or DNS name in the Address field. Proceed to step 3.

The IP address or DNS name appears in the Name field.

3 Type “ipp/” followed by the print connection (print, hold, direct, or name of virtual printer) 

in lowercase letters in the Queue field.

NOTE: The EX Print Server requires a queue name. Do not leave the Queue field empty.

4 Choose Select Printer Software from the Print Using menu. 

5 Locate the copier manufacturer or model in the list, select the printer driver file, and then 

click OK. 

6 Click Add.

The Installable Options pane in the Print & Scan dialog box appears. 

7 Click OK. 

The EX Print Server with its IP address appears in the list of printers.

8 Select EX Print Server.
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9 Click Options & Supplies, and then click the Driver tab.

10 Specify the installable option settings, and then click OK.

For information about configuring installable options, see printer driver Help.

Printing methods

In addition to printing jobs from the EX Print Server printer driver, you can print jobs using 

these methods.

Direct Mobile Printing

Direct Mobile Printing allows direct printing to the EX Print Server from mobile devices, 

such as iPad, iPhone, and iPod touch. The EX Print Server must have certain networking 

options turned on in Setup. After Setup is complete, the EX Print Server appears in the list of 

available printers on the mobile device.

In addition, observe the following configuration requirements:

• Make sure that the EX Print Server is connected to a wireless access point on the network.

• Make sure that supported mobile devices are connected to the same wireless network as the 

EX Print Server. The Printer Default Paper Size is used for all Direct Mobile Printing jobs.

For information about configuring the settings in Setup on the EX Print Server, see “Mobile 

device printing” on page 19.

For a list of supported mobile devices, see “System requirements” on page 12.

TO PRINT FROM A MOBILE DEVICE

1 On the mobile device, open the Print window.

For more information, see the documentation that accompanies your device.

2 Select EX Print Server in the list of available printers.

3 Specify print settings, and click Print.
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PrintMe cloud printing

Users with a PrintMe subscription can a upload document to the PrintMe cloud service and 

then print the document to the copier using the copier touch panel.

In particular, observe the following:

• The PrintMe feature on the EX Print Server requires a subscription to the PrintMe cloud 

service. 

• For information about or support related to the PrintMe cloud service, contact Electronics 

For Imaging at printmesupport@efi.com.

• PrintMe availability may vary, depending on the country or region.

Before you print

• Make sure that the EX Print Server has an Internet connection and is connected to the 

network.

• Turn on PrintMe and related settings on the EX Print Server using Configure.

For information about configuring the settings in Setup on the EX Print Server, see 

“PrintMe cloud printing” on page 20.

• Upload the document to PrintMe, either at www.printme.com or sent by email to 

print@printme.com. 

For more information about using PrintMe, see w3.efi.com/fiery/Products/EFI PrintMe.

• Print directly from a Windows application. To do this, you must first install the PrintMe 

printer driver. For more information, see “Installing the PrintMe printer driver” on 

page 52.

• When you upload or email a document to PrintMe, you receive an email confirmation 

that contains a unique document ID. You need this document ID to print, as described in 

the following procedures.

• Make sure that the copier is not printing or processing any files.

• PrintMe supports the following file types: PDF, XLS, DOC, PPT, GIF, JPG, TIFF, PICT, 

HTML, TXT, and PS. The maximum file size is 25MB.
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TO PRINT A DOCUMENT FROM THE COPIER

1 On the copier touch panel, press the Services Home button.

2 Press the PrintMe icon.

3 Type the Document ID and press Next.

Refer to the email confirmation for Document ID.

Jobs associated with the password are displayed.

Press the Learn About Document ID button to learn how to upload documents to the 

PrintMe cloud service.

4 Select a job to print and then press Print Options.

The following options are provided:

• Copies: Use the keypad on the copier control panel to type a number.

• Duplex: Select One Side, Duplex (duplex flip left) or Tumble (duplex flip up).

• Color mode: Select Color or B/W (black-and-white)

5 Press Print to print the job.

The job is sent to the copier.

6 Press Delete From PrintMe or Exit.

Press Delete From PrintMe to permanently remove all documents associated with the 

Document ID from PrintMe. 

Press Exit to return to the Home screen on the copier.
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Installing the PrintMe printer driver

After installing the PrintMe printer driver, you can print to the PrintMe cloud service just as 

you would print to any desktop printer.

NOTE: The PrintMe printer driver is supported on client Windows computers that operate in 

a non-proxy network environment.

The following procedure describes how to install the PrintMe universal printer driver for 

Windows XP.

TO INSTALL THE PRINTME PRINTER DRIVER

1 Go to www.PrintMe.com/home/ and click Get the driver from the PrintMe toolbar to download 

the PrintMe printer driver.

2 Double-click the EFI PrintMe Driver icon and follow the on-screen instructions.

3 If prompted, restart the computer.

4 To verify that the driver is set up correctly, click Start and select Printers and Faxes.

The EFI PrintMe printer should be listed. If it is not, reinstall the printer driver.

After the PrintMe printer driver is installed, you can print to the PrintMe cloud service from 

most Windows applications.

NOTE: To uninstall the PrintMe printer driver, open the Add/Remove Programs tool in the 

Windows Control Panel and remove the EFI PrintMe Driver.

TO PRINT DOCUMENTS FROM WINDOWS APPLICATIONS

1 In the Windows application, click File > Print.

2 Select EFI PrintMe from the printer pull-down menu.

3 Enter your email address and click OK.

An email message containing the Document ID is sent to your email address.
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Web Services for Devices printing

Web Services for Devices (WSD) allows printing from Windows 7 and Windows 8 

computers, and Windows 8-based tablets. The WSD option on the EX Print Server must be 

turned on in Setup. After Setup is complete, you can install the WSD printer driver for the 

EX Print Server.

For information about configuring the settings in Setup on the EX Print Server, see “Setup 

option reference” on page 13.

TO INSTALL THE WSD PRINTER DRIVER

1 Download the printer driver with WebTools.

For instructions on downloading the Windows printer driver with WebTools, see 

“Downloading printer drivers with WebTools” on page 40.

2 In the Fiery Driver Installer dialog box, select the printer driver language and click Next.

The Fiery Driver Installer installation wizard appears.

3 Click Next to install the Fiery Driver Installer on your computer.

4 Click Next in the Welcome to the InstallShield Wizard for Fiery Driver Installer dialog box.

5 Read the license agreement, click “I accept the terms of the license agreement” and click 

Next. 

6 Select Add a network, wireless or Bluetooth printer.

7 Select the printer from the list of available printers and proceed to step 11.

NOTE: The WSD printer shows the EX Print Server with the printer in parentheses for the 

name of the printer.

If the printer is not listed, proceed to step 8.

8 Click “The printer that I want isn’t listed.”

9 Click Add a printer using TCP/IP address or host name and click Next.

10 Select Web Services Device for Device type, type the IP address of the EX Print Server, and 

click Next.

Connection to the printer is initiated and the printer driver is installed.

11 Click Next and follow the on-screen instructions.

Do not share the printer and do not print a Test Page at this time.

TO PRINT DOCUMENTS FROM WINDOWS APPLICATIONS

1 In the Windows application, select File > Print.

2 Select the EX Print Server WSD printer from the printer pull-down menu.

3 Specify the print options, and click Print.
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Print options

The following table describes the new and modified print options for the EX Print Server.

Option Information

Job Info tab: Print Range Specify the page range or odd/even pages to print.

For variable data printing jobs, a range of Records is selected for printing. For imposed variable data 
printing jobs, a range of Records & Sheets is printed.

For imposed jobs, a range of Sheet IDs is printed.

This option is only accessible from Command WorkStation Job Properties.

Job Info tab: Print queue action Select the job action associated with a published queue.

Select Print to send the file directly to printing.

Select Print and hold to save the raster file after printing.

Select Hold to spool the job until the operator takes further action. Held jobs can exist in a 
preprocessed or processed state.

Select Process and hold to RIP (process), but not print a job.

Select Print and delete to queue a job to be processed, printed, and then deleted. This action ensures 
that the printed job is not saved to the Printed list, which is often required for secure printing.

NOTE: This option is invalid if your job is sent to the Direct connection.

Job Info tab: Proof Print Select Proof Print from the Print button to print a single copy of a job(s) to verify output. 

This action is only accessible from Command WorkStation Job Properties.

Job Info tab: Account ID Account ID is associated with the User ID. Both fields must be filled in when printing jobs. It is used 
to manage print job history on the copier.

The Account ID field has an 32-character (numeric) limit.

Job Info tab: User ID User ID is used to manage print job history on the copier.

The User ID field has an 32-character (numeric) limit.

Job Info tab: Password Specify the account password for a job (up to 12 alphanumeric characters).

Media tab: Use set page device 

media mapping
Set Page Device (SPD) commands are instructions within PostScript, VIPP, and VPS files that specify 
certain attributes of a print job. You can turn on SPD Media Mapping in EX Print Server Setup. For 
information about enabling in Setup, see “Setup option reference” on page 13. 

Select On to allow the EX Print Server to recognize and apply certain attributes of a print job on a job-
level basis, including: 

• Paper attributes (for example, Media Type and Media Color) 

• Finishing attributes (for example, stapling or folding) 

• Generic attributes (for example, simplex or duplex, number of copies)

This option is accessible only from Command WorkStation Job Properties.

For more information, see Configure Help.
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Layout tab: Orientation override Depending on the application you are using, a Landscape job might print with the incorrect 
orientation. If this occurs, use this option to correct the orientation of your job.

This option is accessible only from Command WorkStation Job Properties.

Layout tab: Orientation Specify Portrait or Landscape page orientation for the document.

This option is not available from the Mac OS X printer driver and Command WorkStation Job 
Properties.

Layout tab: Mirror Select to print the mirror image of the job.

This option is not available from the Mac OS X printer driver and Command WorkStation Job 
Properties.

Color tab: Optimize RGB 

transparency
Turn on to achieve correct color output for areas of overlapping transparent RGB or Lab colors (such 
as a drop shadow) in a PDF job. When the Adobe PDF Print Engine Preferred is turned on, this 
option is to recognize blending color spaces in the job, which can improve output for some blend 
modes when RGB blending color spaces are used.

This option is only accessible from Command WorkStation Job Properties, Hot Folders, and Virtual 
Printers.

For more information, see “Optimize RGB Transparency” on page 70.

Finishing tab: Use set page 

device output bin tray mapping
Select On to allow the EX Print Server to map the Output Bin Tray on a job-level basis. Set Page 
Device (SPD) Media Mapping must be turned on in EX Print Server Setup to use this option. For 
information about enabling in Setup, see “Setup option reference” on page 13. 

This option is only accessible from Command WorkStation Job Properties.

For more information, see Configure Help.

Finishing tab: 

Cover page options: Cover page 

face-down printing

Select the delivery for a cover page on per job basis.

Finishing tab: 

Cover page options: Cover page 

feed direction

Select Long edge or Short edge for the orientation of the cover page.

Finishing tab: 

Trim: Spine pressing 
Use to compress the spine edge of your booklet print job. 

NOTE: This option requires a 5-sheet minimum. 

Finishing tab: 

Trim: Engage fore (face trim)
Select to trim the edges of your booklet print job. 

NOTE: This option uses a standard calculation based on the number of sheets, page size, media type 
and weight, and spine width of your booklet. Use the separate Trim value option to fine-tune the 
amount of trimming. 

NOTE: To use this option, you must install a finisher with trimming capabilities. 

Finishing tab: 

Trim: Finish size 
When Engage fore (face trim) is selected, use to specify the finished booklet size after trimming. 

The finish size increment is 0.1 mm (0.001 inch).

Option Information
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Finishing tab: 

Trim: Trim value
When Engage fore (face trim) is selected, use to adjust the amount of trimming. 

The trim value increment is 0.1 mm (0.001 inch).

VDP tab: Enable enhanced 

FreeForm
Select to allow the mapping of select pages from the FreeForm master file in the desired order and 
merge with the variable file when the job is processed.

NOTE: You cannot apply FreeForm settings to an imposed job.

For more information, see “Enhanced FreeForm” on page 78.

Option Information
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ADDENDUM TO UTILITIES

This chapter describes additions and corrections to Utilities, which provides an overview of 

how to install, configure, and use the EX Print Server software utilities.

The Productivity Package is not supported for the EX Print Server.

The following chapters have been updated for this version of the EX Print Server: 

• Installing user software (see page 58)

• Command WorkStation (see page 59)

Includes information on the following new utilities:

– Image Enhance Visual Editor (see page 59)

– Soft Proofing (see page 59)

– Image Enhance (see page 59)

– Job error report (see page 59)

In addition, the following improvements to Command WorkStation are described:

– Changes to Preferences, including default finish size (see page 60)

– Applying server presets from the Job List

– In-line editing of job name and number of copies

• Fiery JobMaster, Impose, and Compose (see page 61)

Includes information on new Fiery JobMaster application and any updates to Fiery Impose 

and Fiery Compose, which were previously part of Fiery SeeQuence Suite.

• Fiery Scan (see page 64)

Includes information on new Fiery Remote Scan application.

• Paper Catalog (see page 66)

• Fiery Hot Folders (see page 66)

• WebTools (see page 67)
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Installing user software

This section updates the related information in the Installing User Software chapter in 

Utilities.

Before installing EX Print Server user software, you must disconnect any measurement 

instrument from the computer. Otherwise, after installation the instrument may not be 

recognized by the software. 

Before installing EX Print Server software on a Windows computer, be sure to complete the 

following:

• Make sure that your computer meets the minimum system requirements. For information 

about system requirements, see Welcome and “System requirements” on page 12.

If the latest service pack is not installed, a warning message alerts you to install it.

• The Java file, Java Runtime Environment (JRE), provided in the Common Utilities folder 

on the User Software DVD, must be installed on your computer. If the correct Java file is 

not installed, the Fiery User Software Installer installs the required version automatically 

before installing the EX Print Server software.

After installation of Java JRE, a Java Web Start shortcut is created on your computer 

desktop. The shortcut is not intended for use with EX Print Server user software and can 

be deleted.

TO INSTALL USER SOFTWARE ON A MAC OS COMPUTER FROM THE USER SOFTWARE DVD

1 Insert the User Software DVD into the DVD drive.

2 In the User Software window, double-click the icon for the application that you want to 

install.

3 Follow the on-screen instructions.

TO UNINSTALL USER SOFTWARE ON A MAC OS COMPUTER

1 Insert the User Software DVD into the DVD drive of your computer.

2 Click the icon for the Fiery Software Uninstaller.

3 Drag the Fiery Software Uninstaller icon to your Applications folder.

4 Choose Go > Applications > Fiery Software Uninstaller.

5 Select the software that you want to uninstall and follow the on-screen instructions.



ADDENDUM TO UTILITIES 59

Command WorkStation

This section supplements the Command WorkStation chapter. New features accessible from 

Command WorkStation and updates are described in this section. 

NOTE: The following utilities are offered as options:

• Fiery Impose

• Fiery Compose

• Fiery JobMaster

• Fiery Graphic Arts, Premium Edition 

Soft Proofing

Soft Proofing allows you to view accurate color previews of print jobs on a monitor. Use soft 

proofs to preview colors as they will appear when the job is printed. Access Soft Proofing 

through the Preview window in Command WorkStation. 

Image Enhance

The Image Enhance print option is configurable from Command WorkStation, in Device 

Center > Workflows > Image Enhance. For more information about the Image Enhance print 

option and how to configure it, see Command WorkStation Help.

Image Enhance Visual Editor

With Image Enhance Visual Editor, you can adjust tone, color, and sharpness, and perform 

red-eye correction. You can apply the same adjustments to all images on a page or a range of 

pages. When you save a set of adjustments as a preset, you can easily apply the same 

adjustments in the future. For information about using Image Enhance Visual Editor, see 

“Image Enhance Visual Editor” on page 68.

ImageViewer

If Fiery Graphic Arts Package, Premium Edition is installed and enabled on the EX Print 

Server, you can use ImageViewer to preview and adjust colors on a job that has been processed 

and held. For information about using ImageViewer, see Fiery Graphic Arts Package.

NOTE: When available, ImageViewer can be used instead of the standard Preview window 

described in Command WorkStation Help.

Job Error Report

If you encounter any errors while processing or printing a job, you can create a job error 

report in Command WorkStation for troubleshooting purposes. 
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For more information, see “Job error reports” on page 21.

Command WorkStation preferences

The contents of the Regional Settings and Size panes in Command WorkStation Preferences 

have been reorganized.

The Command WorkStation Preferences Size pane includes an option to define whether the 

default finish size for imposed jobs is based on Crop Box or is User Defined. This default 

setting populates the Finish Size option in Fiery Impose and only applies to jobs opened in 

Impose. It does not apply to jobs to which an impose template is applied from Job Properties 

or Hot Folders, for example.

Apply Preset menu

You can apply a server preset directly to a job in the Job List from the right-click Apply Preset 

menu, which lists all server presets alphabetically.

In-line editing of job name and number of copies

You can edit the job name and number of copies directly from the Job List, by typing 

information into the fields. A subtle gray bullet in the fields indicates that the fields are 

editable, and when you point to the field, an edit box appears.

Help

Command WorkStation Help provides information about all new features. 
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Fiery JobMaster, Impose, and Compose

This section replaces the Fiery SeeQuence Suite chapter in Utilities.

Fiery JobMaster is a new application accessed from Command WorkStation. Fiery Impose 

and Compose were formerly known as Fiery SeeQuence Suite. All three applications are part 

of Fiery make-ready software, which integrates labor-intensive document preparation 

activities at both the sheet level and page level in one visual interface. These integrated job 

preparation tools offer the following modes, depending on what (if any) client license is 

available:

• Preview provides a pre-rip job preview and is a standard feature of Command 

WorkStation. Users can do a soft proof of each sheet surface of a job before it is processed. 

The visual interface changes dynamically to display any changes made in preparing 

documents for printing. 

• Fiery JobMaster provides advanced PDF-based job preparation tools for scanning, tab 

creation and insertion, page numbering, chapter creation, and late stage editing. It 

includes all functions of Fiery Compose.

• Fiery Impose applies imposition layouts to jobs for custom printing, binding, and 

trimming. Impose also applies impositions to variable data jobs and saves imposed jobs as 

PDF files.

• Fiery Compose allows you to define the chapter divisions of a job, print ranges of pages on 

varying types of media, insert blank media between pages, and insert tab media containing 

text labels (if the copier supports tab printing). 

• Fiery JobMaster, Impose, and Compose features are integrated in the Preview window.

About Fiery JobMaster, Impose, and Compose Kits

The Fiery make-ready applications are available in the following kit configurations:

• Fiery JobMaster kit (includes the Adobe Acrobat/Enfocus PitStop DVD and a License 

Activation Code)

• Fiery Impose kit (includes the Adobe Acrobat/Enfocus PitStop DVD and a License 

Activation Code)

• Fiery Compose kit (includes the Adobe Acrobat/Enfocus PitStop DVD and a License 

Activation Code)

The Fiery make-ready applications are supported on both Windows and Mac OS computers. 

For information about system requirements, see Welcome and “System requirements” on 

page 12.
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NOTE: You must have the software kit-specific license installed on your computer to use the 

full functionality of the software. If you do not have the license installed, Fiery JobMaster and 

Compose settings are not available, and Fiery Impose runs in Demo mode. In Impose Demo 

mode, imposed jobs print with a watermark, and you can save imposed jobs in .dbp format to 

the EX Print Server. You can save imposed jobs in Adobe PDF format to a hard drive and the 

EX Print Server when you are in Demo mode, but they are saved with a watermark. 

Installing Fiery make-ready applications

Fiery JobMaster, Impose, and Compose software is installed with Command WorkStation 

software. For information on installing Command WorkStation software, see Utilities > 

Installing User Software.

Enabling Fiery make-ready applications

Fiery JobMaster, Impose, and Compose are license-protected features of Command 

WorkStation that work in conjunction with Adobe Acrobat and the Enfocus PitStop plug-in. 

You must install a special license on each computer that runs the software. This section 

explains how to install the license and the required software. Note the following:

• The License Activation Code is provided on a card in your kit.

• If you have purchased an earlier version of Fiery Impose or Fiery Compose, you can use 

the dongles you already own to enable Fiery Impose or Fiery Compose.

• Acrobat must be installed on the same computer as the Fiery make-ready software to 

preview .ps files. You do not need Acrobat or PitStop to preview .pdf files.

If you are enabling Fiery make-ready software on the EX Print Server, the following 

procedures assume that you have logged on to the EX Print Server with Administrator 

privileges and typed the appropriate password. To ensure network security, the system 

administrator may change this password frequently. Consult your administrator to obtain the 

password.

TO INSTALL A LICENSE

1 In Command WorkStation, right-click a job and choose JobMaster, Impose or Compose. 

2 If you are asked whether to activate the option, click Yes. Otherwise, choose Help > Manage 

License. 

NOTE: You can also select Preview in step 1, and choose Help > Manage License. 

3 In the License Activation window, click Activate.

4 To agree to the terms and conditions of the license agreement, click Continue. 

5 For License Activation Code, type the LAC and click Continue. 

6 If the Fiery option name is correct, click Activate. 

The Fiery option is activated. 
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7 Click Finish. 

For information about the activation process, click the Help icon in the License Activation 

window.

Install Acrobat and PitStop, as described in the following procedure.

TO INSTALL ACROBAT AND PITSTOP

1 If the most recent versions of Adobe Acrobat and Enfocus PitStop are not installed, uninstall 

the versions of Adobe Acrobat and Enfocus PitStop that are currently resident on the 

computer.

• Close all open applications.

• Follow the instructions for your computer for removing programs.

• After you finish uninstalling earlier versions of Acrobat and PitStop, restart the computer. 

2 Close all software applications that are currently running on the computer.

3 Insert the Adobe Acrobat/Enfocus PitStop DVD (Windows or Mac OS) into the DVD drive.

4 If the installer does not start automatically, navigate to the root level of the DVD and double-

click Setup.exe (Windows) or Setup.app (Mac OS).

5 On Mac OS X, click Install and follow the on-screen instructions. 

On Windows, select the language and click Next.

The software option that you purchased is now fully enabled.

VDP raster preview

You can view a processed imposed VDP job’s sheet surfaces grouped by records or by finished 

sets. Navigate through the job by clicking navigational arrows.

About Help

Fiery JobMaster, Impose, and Compose Help are accessed from the Fiery JobMaster window. 

Fiery Impose and Compose help are part of Command WorkStation Help. For instructions 

on using Impose and Compose, see Command WorkStation Help.

The Help menu offers access to the following kinds of Help:

• Online Help provides procedural information.

• How To accesses the EFI web page, which provides demo scripts and sample files.

• What’s New describes the new features of Command WorkStation.

TO ACCESS COMMAND WORKSTATION HELP

1 Start Command WorkStation.
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Select the EX Print Server from the Server List dialog box and log on to the server (see Utilities 

> Command WorkStation > Configuring the connection to the EX Print Server).

2 Choose Help, How To, or What’s New from the Help menu.

Or press F1 when the cursor is in an area of the main Command WorkStation window.

Fiery Scan

This section updates the information about Fiery Remote Scan in the Scan chapter in 

Utilities.

Fiery Scan includes a new version of Fiery Remote Scan, accessible as a separate application 

and as a TWAIN plug-in. Installation of Fiery Remote Scan components has not changed 

from the previous version of EX Print Server user software. The method of configuring the 

connection to the EX Print Server has changed and is described below.

After you install Fiery Remote Scan, access it as follows:

• The Remote Scan application is a separate application started from your desktop. The 

Remote Scan application allows you to initiate scan files and retrieve scan files from a 

mailbox.

• The Remote Scan TWAIN plug-in module is used with compatible TWAIN compliant 

applications, such as Adobe Photoshop or Adobe Acrobat. You can directly acquire the 

scan into the application. 

NOTE: Multiple Fiery Remote Scan TWAIN users can simultaneously access the same EX 

Print Server.

Configuring Fiery Remote Scan

When you open Fiery Remote Scan for the first time, you must configure the connection to 

the EX Print Server. You can add more than one EX Print Server to the Fiery Server list in 

Fiery Remote Scan and select the required one from the list. 

To configure the connection, you need the name or IP address of the EX Print Server. If you 

do not have the name or IP address, use the Search function to find the EX Print Server on 

your network.

After first use, Fiery Remote Scan automatically attempts to connect to the last EX Print 

Server used in the previous session. You can immediately start to initiate a scan or retrieve any 

scans initiated at the copier touch panel, and use Fiery Remote Scan Help.

Instructions for configuring and modifying the connection to the EX Print Server are 

provided in Fiery Remote Scan Help and in the following procedures.

TO CONNECT TO THE EX PRINT SERVER

1 Open Fiery Remote Scan.
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2 Click the “Choose a Fiery” icon (magnifying glass) to open the Connect to Server dialog box.

3 Type the name or IP address in the Connect to a server field. 

If you do not have the name or IP address, see “To perform an advanced search” on page 65.

4 Click the plus sign icon to add it to the server list.

When you click the plus sign, you add the EX Print Server to the list, but do not connect to it. 

This operation is useful when you want to add more than one EX Print Server in a session. 

You can then switch between any EX Print Server in the Fiery Remote Scan window without 

opening the Connect to Server dialog box.

5 Click Connect or Cancel.

Clicking Connect adds the EX Print Server to the list at the same time as connecting to it. If 

the connection was successful, the Fiery Remote Scan window opens. 

If you clicked Cancel, all operations that you did to add or remove the EX Print Server are 

cancelled. Any server list changes are discarded.

If you do not have the specific name or IP address of the EX Print Server, you can search by IP 

ranges or by subnet.

TO PERFORM AN ADVANCED SEARCH

1 In the Connect to Server dialog box, click the Choose a Fiery icon (magnifying glass) to open 

the Search dialog box.

2 Select Auto Search or select IP Range or Subnet to specify the range to search, and then click 

Go.

Any available EX Print Server that matches the search criteria is shown. You can filter the 

search result list by typing a keyword in the Filter by keyword field.

3 Select the EX Print Server from the results list and click Add.

4 To add another EX Print Server to the list for later use, click the plus sign in the Connect to 

Server dialog box.

5 In the Connect to Server dialog box, click Connect to add the EX Print Server to My Fiery List 

and connect to it.

If you clicked Connect and the connection was successful, the Fiery Remote Scan window 

opens. 

If you clicked Cancel, all operations that you did to add or remove any EX Print Server are 

cancelled. Any server list changes are discarded.
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Using Fiery Remote Scan

You can initiate scanning remotely with Fiery Remote Scan and the TWAIN plug-in module, 

or retrieve files from the mailbox. If you are using Fiery Remote Scan, you can choose where 

to save the scanned file. If you are using the TWAIN plug-in module, you can open the scan 

file in a host application for editing purposes.

Instructions for using the Fiery Remote Scan application and plug-in module are provided in 

Fiery Remote Scan Help, accessed by clicking the Help icon in the Fiery Remote Scan 

window. 

Retrieving scans

You can retrieve scans from a mailbox using WebTools Docs, Remote Scan, or Fiery Bridge. 

Fiery Bridge is available for Windows only. 

Paper Catalog

This section supplements the Paper Catalog chapter in Utilities.

In addition to defining media entries in Paper Catalog on the EX Print Server, you can also 

define media entries on the copier. Media entries are synchronized so that the same media are 

displayed on both the copier touch panel and in Paper Catalog.

New features

Media can be assigned to trays using a right-click menu, which shows all media entries that 

can be assigned to the tray. 

Smart Media: allows automatic tray association when a user's favorite media is loaded in a tray. 

Also pre-populates Media Attributes fields in Paper Catalog to help create a new media.

Support for JDF tabs: Tab properties as defined by JDF spec 1.4 are now supported and are 

included as options for media attributes when defining a new media entry.

All new features are described in Paper Catalog Help.

Fiery Hot Folders

This section supplements the Hot Folders chapter in Utilities.

Hot Folders provide a simple and automated method of sending print jobs to the EX Print 

Server across the network. The user drops documents into a folder that stores and reuses 

preset print options for printing PostScript and PDF files on the EX Print Server. 

The following formats are now supported for submission through Hot Folders to the EX Print 

Server:
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• JDF (Job Definition Format) jobs, when JDF submission is enabled on the EX Print 

Server

• PDF/VT jobs for variable data printing

All new features are described in Hot Folders Help. 

WebTools

This section provides some additional information that may be useful in accessing WebTools 

from a client computer. The section supplements the WebTools chapter in Utilities.

Windows 2008

If you start WebTools with Internet Explorer from a Windows 2008 computer and Java 

Runtime Environment (JRE) is not installed, Internet Explorer may appear blank and will not 

prompt you to install JRE. However, WebTools Configure downloads JRE and runs as 

expected on Windows 2008 (32-bit) if the Internet Explorer Enhanced Security 

Configuration is disabled. 

Pop-up Blocker with WebTools

Pop-up Blocker is turned on by default in some versions of Internet Explorer on Windows 

computers. With this function turned on, a warning message appears when you attempt to 

access WebTools, and access to WebTools is denied. To gain access, do one of the following:

• Change the Pop-up Blocker setting by clicking the warning message and choosing one of 

the selections that appears.

• Turn off Pop-up Blocker in the Internet Explorer Tools menu. 

If your browser has the advanced Internet option enabled to display notifications about script 

errors, it might display a warning window before displaying a Help file. To avoid the warning 

window, clear the “Display a notification about every script error” option on the Advanced 

tab in the Internet Options dialog box. A warning message might also appear in the Status 

bar, but the content of the Help file is not affected by this error.

For more information, see Internet Explorer Help, or the documentation that accompanies 

the Windows operating system.
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ADDENDUM TO COLOR PRINTING

This chapter describes additions and corrections to Color Printing.

Fiery Productivity Package

Fiery Productivity Package is not a supported option for the EX Print Server.

Image Enhance Visual Editor

IEVE is an image editing application that provides users with a visual workspace to adjust 

individual images in a job. With IEVE, you can see the effects of your adjustments and fine-

tune the appearance of an image.

With IEVE, you can adjust tone, color, and sharpness, and perform red-eye correction. You 

can apply the same adjustments to all images on a page or a range of pages. When you save a 

set of adjustments as a preset, you can easily apply the same adjustments in the future.

Adjustments made in IEVE affect the job on the EX Print Server and cannot be applied to the 

original source document.

IEVE is accessible from Command WorkStation. For more information about IEVE, see 

IEVE Help.

Accessing IEVE

Start IEVE from the Actions menu of Command WorkStation.

TO START IEVE FROM THE ACTIONS MENU

1 In Job Center in Command WorkStation, select the job containing the images that you want 

to adjust.

NOTE: IEVE supports PDF and PostScript jobs only.

2 To start IEVE, do one of the following:

• Select Image Enhance Visual Editor from the Actions menu.



ADDENDUM TO COLOR PRINTING 69

• Right-click the selected job and select Image Enhance Visual Editor from the menu 

that appears.

The Image Enhance Visual Editor window appears.

IEVE and Image Enhance print option

IEVE adjustments are independent of the configurable Image Enhance print option. If the 

Image Enhance print option is turned on for a job that is also modified with IEVE, the effects 

of both are applied to the images in the job. We recommend that you use one or the other, not 

both, for a job.

• The Image Enhance print option is a faster way to apply simple adjustments that do not 

require visual confirmation before printing. 

• IEVE is faster for making selective adjustments that require fine-tuning and visual 

inspection. 
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Optimize RGB Transparency

The Optimize RGB Transparency option affects jobs with the following characteristics:

• The job is in PDF format (submitted to the EX Print Server as a PDF file, not submitted 

from an application through a printer driver).

• The job contains transparent RGB or Lab objects. They might be objects that you 

specified as transparent using an application that supports this capability, or they might be 

objects with a special effect, such as a drop shadow, that uses transparency to achieve the 

effect.

• The transparent objects overlap, creating an area of mixed color. 

If you turn on Optimize RGB Transparency, the EX Print Server uses the correct RGB source 

profile and rendering intent when converting the overlapping RGB colors to CMYK during 

the PDF-to-PostScript conversion. If you turn off Optimize RGB Transparency, the area of 

overlapping colors might print with incorrect color or undesirable artifacts. 

When Adobe PDF Print Engine Preferred is turned on, the EX Print Server does not convert 

the PDF job to PostScript when processing the job. In this case, the effect of Optimize RGB 

Transparency is to recognize blending color spaces in the job, which can improve output for 

some blend modes when RGB blending color spaces are used.

Optimize RGB Transparency can result in a longer processing time, especially for variable data 

printing (VDP) jobs that contain multiple individual PDF pages. We recommend that you 

enable Optimize RGB Transparency only when necessary to achieve correct color output.

You can specify Optimize RGB Transparency for a job in Job Properties in Command 

WorkStation, Hot Folders, or a virtual printer, but not when you print from the printer 

driver. The Optimize RGB Transparency option does not appear in the printer driver because 

jobs printed from the printer driver are always submitted to the EX Print Server as PostScript 

jobs, which are not affected by Optimize RGB Transparency.
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Color profiles

The list of profiles that are included on the User Software DVD has changed. The following 

table replaces the table in EX Print Server Color Printing > Color Profiles > Installing 

additional ICC profiles on your computer.

Location on User Software 
DVD

Profiles

Adobe ICC Profiles folder 

(inside the Windows Color 

Files\Legacy\ICC Profiles 

folder or Mac Color Files/

Legacy/ICC Profiles folder)

These profiles were created by Adobe Systems, Inc. For more information, see the 

documents included in the folder.

CMYK Profiles:

• CoatedFOGRA27.icc

• CoatedFOGRA39.icc

• CoatedGRACoL2006.icc

• JapanColor2001Coated.icc

• JapanColor2001Uncoated.icc

• JapanColor2002Newspaper.icc

• JapanColor2003WebCoated.icc

• JapanWebCoated.icc

• UncoatedFOGRA29.icc

• USWebCoatedSWOP.icc

• USWebUncoated.icc

• WebCoatedFOGRA28.icc

• WebCoatedSWOP2006Grade3.icc

• WebCoatedSWOP2006Grade5.icc

RGB Profiles:

• AdobeRGB1998.icc

• AppleRGB.icc

• ColorMatchRGB.icc

• PAL_SECAM.icc

• SMPTE-C.icc

• VideoHD.icc

• VideoNTSC.icc

• VideoPAL.icc
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ECI folder 

(inside the Windows Color 

Files\Legacy\ICC Profiles 

folder or Mac Color Files/

Legacy/ICC Profiles folder)

These profiles were created by the European Color Initiative (ECI). For more information, 

see the documents included in the CMYK Profiles and RGB Profiles folders, as well as the 

ECI web site at www.eci.org.

CMYK Profiles:

• ISOcoated_v2_300_eci.icc

• ISOcoated_v2_eci.icc

• ISOuncoatedyellowish.icc

• PSO_Coated_300_NPscreen_ISO12647_eci.icc

• PSO_Coated_NPscreen_ISO12647_eci.icc

• PSO_LWC_Improved_eci.icc

• PSO_LWC_Standard_eci.icc

• PSO_MFC_Paper_eci.icc

• PSO_SNP_Paper_eci.icc

• PSO_Uncoated_ISO12647_eci.icc

• PSO_Uncoated_NPscreen_ISO12647_eci.icc

• SC_paper_eci.icc

Location on User Software 
DVD

Profiles
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EFI Support folder 

(inside the Windows Color 

Files\Legacy\ICC Profiles 

folder or Mac Color Files/

Legacy/ICC Profiles folder)

These profiles were created by EFI. For more information, see the General Requirements 

for Applications in Commercial Offset Lithography (GRACoL) website at 

www.gracol.org, the Fogra website at www.fogra.org, and the Specifications Web Offset 

Publications (SWOP) website at www.swop.org.

CMYK Profiles:

• EFIEURO.icc

• EFISWOP.icc

• Enterprise CMYK.icc

• GRACoL2006_Coated1_EFI.icc

• ISOCoated.icc

• ISOCoated_FOGRA39L_EFI.icc

• ISOUncoated_FOGRA29L_EFI.icc

• SWOP2006_Coated3_EFI.icc

• SWOP2006_Coated5_EFI.icc

RGB Profiles:

• EFI Fiery RGB Chroma.icc

• EFI Fiery RGB Chroma+.icc

• EFI Fiery RGB Chroma++.icc

NOTE: The EFI Fiery RGB Chroma profiles are designed to provide saturated colors, 

especially in nighttime images, while maintaining photographic detail. Of the three 

profiles, EFI Fiery RGB Chroma.icc has the least effect and EFI Fiery RGB Chroma++.icc 

has the greatest effect.

• EFIRGB.ICC

• Fiery RGB v2.icc

• Fiery RGB v4.icc

• Fiery RGB v5.icc

• RGB D65 (Splash).icc

Location on User Software 
DVD

Profiles
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Other color files

The color files listed in EX Print Server Color Printing > Color Profiles > Other color files, 

except for the files in the Color Bars folder, are not applicable to this version of the EX Print 

Server.

Calibration

Calibration methods

DTP32, DTP32 Series II, and DTP41 are no longer supported calibration methods. 

The EFI ES-2000 spectrophotometer is supported as a calibration method. For more 

information, see Calibrator Help.

Checking calibration status

You can verify whether the EX Print Server is calibrated in Command WorkStation.

TO CHECK THE CALIBRATION STATUS FOR A JOB

• In Command WorkStation, in Job Center, select the job.

The time of the most recent calibration is displayed in the lower-right corner.

EFI Support folder 

(inside the Windows Color 

Files\Legacy\ICC Profiles 

folder or Mac Color Files/

Legacy/ICC Profiles folder)

Japan Profiles:

• EFIDIC.ICC

• EFIJMPA2.icc

• EFIJMPA3.icc

• JapanColor2011Coated.icc

• JC2001_type1_EFI.icc

• JC2001_type2_EFI.icc

• JC2001_type3_EFI.icc

• JC2001_type4_EFI.icc

• TOYO Offset Coated 2.0.icc

Location on User Software 
DVD

Profiles
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TO CHECK THE STATUS OF A CALIBRATION SETTING

1 In Command WorkStation, in Device Center, select General > Tools and click Manage under 

Calibrate.

The list of calibration settings on the EX Print Server appears in Calibrator. 

2 Check the “Last calibrated” column for the particular calibration setting.

This column shows the last time the EX Print Server was calibrated for the calibration setting. 

“Default measurements” indicates the factory settings.

You can set Calibrator preferences to optionally display a warning or suspend printing if 

calibration is out of date. For more information, see Calibrator Help. 

Enabling Device Color Space not applicable

The information in EX Print Server Color Printing > Calibration > Calibrating with ColorCal 

> Enabling the Device Color Space setting for ColorCal is not applicable for this version of 

the EX Print Server.

Recommended paper and print settings

The information in EX Print Server Color Printing > Calibration > Managing calibration sets> 

Using the output profiles and calibration sets > Recommended paper and print settings is not 

applicable for this version of the EX Print Server.

Use the following procedure to find the recommended paper and print settings for a particular 

output profile in Calibrator.

1 Last calibrated

1
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TO FIND THE RECOMMENDED PAPER AND PRINT SETTINGS FOR AN OUTPUT PROFILE

1 In Command WorkStation, in Device Center, select Color Setup > Color Management.

2 Select the output profile and note the name of the calibration setting displayed to the right.

3 In Device Center, select General > Tools and click Manage under Calibrate.

The list of calibration settings on the EX Print Server appears in Calibrator.

4 Select the calibration setting from the list.

The recommended paper is shown in the list and the required print settings are displayed in 

the Calibration related properties area.

5 Click Close to close the window.

Adding custom calibration sets and profiles

The information in EX Print Server Color Printing > Calibration > Managing calibration sets 

> Adding custom calibration sets and profiles is not applicable for this version of the EX Print 

Server. A calibration target is created when you create a new calibration set. You do not need 

to create a target and add it to the output profile.

1 Recommended paper

2 Required print settings

1

2
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ADDENDUM TO VARIABLE DATA PRINTING

This chapter describes additions and corrections to Variable Data Printing.

Creating the variable document

To create the variable document, you need a word processing application that provides a mail 

merge function, a database application, or a page layout application that supports scripting.

TO CREATE THE VARIABLE DOCUMENT

1 From your supported application, create the variable document to conform to the layout of 

the master document.

2 Add the variable information in the appropriate places in your document.

Your application creates the information taken from a list or database and merges it into an 

existing document that is designed to accept the master information. Each application has 

different controls for this function. For detailed instructions, see the documentation that 

accompanies your application. 

NOTE: You must create a variable document with the same page count as the master page 

document. For example, if a master document has a record length of four pages, all the 

variable documents must have a record length of four pages. Use Enhanced FreeForm to add 

empty pages to the last record of the variable document, if necessary (see “Enhanced 

FreeForm” on page 78).

3 Save the file.

Variable document

1 Variable element

1

1

1

1
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Enhanced FreeForm

Enhanced FreeForm allows you to map the master and variable file in a user-defined order, 

eliminating the need to add blank pages to get the desired merged output. Unlike FreeForm, 

when merging master and variable files, the page order is fixed.

TO MAP MASTER AND VARIABLE FILES WITH ENHANCED FREEFORM

1 Select a FreeForm job and click the VDP tab in Job Properties.

2 From Use Master, select a FreeForm master. 

NOTE: Make sure that you know the number of master pages used for your job when you 

select the FreeForm master.

3 Select Enable Enhanced FreeForm and click Define Mapping.

You can map any page in the master to any page of the variable document. The master may 

contain more pages than the final document. Additionally, the variable document record 

length does not have to match the total number of master pages.

4 In “Variable Pages per record,” enter the number of pages per record for your job.

5 If you want to preview your master page, click Preview Master, and then click Close when you 

are finished previewing the file.

6 In “Total pages per record to be finished,” enter the record length after all the masters and 

variables are merged for your job, and then click Continue.

The Total Pages column displays the total number of pages in your record and the page order 

of your master file and variable page.

7 Map each page from the Variable Pages column to a master page from the Master Pages 

column.
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8 If there are master pages that are not assigned to a variable page, use the up and down 

arrows to arrange the page order of these pages.

9 Click OK, and then click OK to print your job.
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ADDENDUM TO FIERY GRAPHIC ARTS PACKAGE

This chapter describes additions and corrections to Fiery Graphic Arts Package.

The features of Fiery Graphic Arts Package are standard with this version of the EX Print 

Server.

• Halftone simulation

• Soft proofing

• Multiple plate separations

• Hot Folders TIFF/IT filter

• Paper Simulation print option
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